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1. Device

1.1. Components
• Weighing scale

• Scale display unit

• Tape measure

• Steel hammer (100 g)

• Battery and charger

• Microphone

• USB to serial converter cable

• Portable Lumber Grader Software

1.2. Minimum software requirements
• Operating system: Windows 7 SP1 (recommended: Windows 10 or newer)

• Processor: 1 GHz

• RAM: 512 MB

• Disk space: 300 MB

• 1 free USB port

2. Principles of measurement
The portable Lumber Grader is designed to estimate strength classes of structural timber, 
as defined in the EN 338 standard (see Appendix 2: EN 338) The software handles two 
different species classes: deciduous and coniferous (including poplar). Grading is based 
on the modulus of elasticity (MoE) and the average specific gravity of the lumber.

3. Connection to computer
• Connect the microphone's cable to the microphone socket of the computer

• Connect the weighing scale to the scale display unit

• Connect the RS-232 cable from the scale display unit to the computer,  using the 
USB-to-serial converter cable

• Place 4 fully charged AA batteries into the Rinstrum force meter Display Unit.
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3.1. Half weight setup
Below you can see the setup for measuring half lumber load. Recommended for longer 
samples where length is larger than 2 meters.

3.2. Full weight setup
Below you can see the setup for measuring full lumber load. Recommended for shorter 
samples where length is below 2 meters.

3.3. Indicate the setup in the software
Select whether the weighing scale is at the center of the lumber 
(“Measuring full weight”), or at one of it’s ends (“Measuring half 
weight”).

3.4. Selecting audio input device

• Connect the microphone cable to the PC

• The software selects the current default audio device of the computer automatically 
when the application starts.

• In case there are  multiple  audio  input  devices  available,  select  the one that  the 
microphone  in  use  is  connected  to  from  the  “Audio  device” selector.  (On  some 
systems audio output is  also available as a  virtual  microphone.  Ignore items like 
“Stereo mixer”, “CD volume”, “Line volume”)
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3.5. Selecting scale USB port

• Connect the USB-Serial cable to the PC

• Select the COM port of the scale from the “Weight measurement” selector (1)  and 
click “Open” (2).

3.6. Connection state
Colored strips indicate the current state of the connection to the audio and scale devices:

• “Inactive” (gray): No connection found, press “Open”.

• “Connecting” (yellow): the PC tries to connect.

• “Reading” (green): the PC is receiving data.

• “No  data”  (yellow):  there  is  no  data  flow  through  the 
connection. Verify that the correct device is selected and the 
device is turned on.

• “Error” (red):  there was an issue with  the connection.  If  the 
error state persists for more than 5 seconds then click “Close”, 
and once “Inactive” click “Open”.

• “Disconnecting” (yellow): the PC tries to disconnect.

4. Setting up measurement in software
Before taking measurements, the following parameters should be entered: the audio 
“Trigger” level and whether the weighing scale measures full or half weight.

4.1. Audio and Trigger level
The software is constantly recording from the Microphone to 
detect hits from the hammer. To separate background noise 
from hits, the user must calibrate the software for the sound 
volume that hitting the lumber produces.

• The “Audio level” plot indicates the current volume recorded 
from  the  microphone.  The  light  blue  bar  represents  the 
current  volume,  and  changes  quickly.  The  dark  blue  bar 
indicates  the  maximum  volume  recently  recorded,  and 
changes  more  slowly.  The  black  text  above  the  dark  blue  bar  shows  the  recent 
maximum volume in decibels.
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• The  “Trigger” is  the  minimum  level  of  volume  that  hammer  hits  produce.  It  is 
indicated by the red line in the “Audio level” plot, as well as the red text and slider 
position in the “Trigger” column.

• After hits the top of the dark blue bar should be above the trigger level, while without 
hits it should be consistently well below it.

• Most audio devices will provide  “Mono” output, but in case stereo 
audio is recorded the audio channel to use needs to be selected 
(“Left” or “Right”).

4.2. Tare
Before taking measurements, use the Rinstrum display 
unit to tare (zero) the measurement when the scale is 
unloaded.

4.3. Settings window
Review the application settings, especially the “Auto-increment min. sample count” field 
on the “Misc.” tab. Using this field you indicate whether you want only a single 
measurement per lumber, or multiple. (For more details see: 8.3 Miscellaneous settings)

5. Measurement procedure

5.1. Lumber placement
Place the lumber in the position indicated in chapter 3.3 Indicate the setup in the 
software. When measuring full weight, ensure the scale is placed under the center of the 
lumber for precise measurements. When measuring half weight ensure that the end of 
the lumber is placed on the center of the scale.

5.2. Properties of the next lumber sample
Entering the parameters of the next lumber sample to be 
measured is critical for correct grading.

• “Coniferous”, “Deciduous”: Select the lumber type.

• “Length [cm]”, “Width [cm]”, “Height [cm]”: Enter the 
nominal  dimensions of  the lumber  in  centimeters. 
You may use the decimal point for precise entry.

• “Current  moisture  content  [%]”:  The  moisture 
content of the lumber while grading

• “Service moisture content [%]”: The expected in-use  
moisture content
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• “CKDR” (Concentrated Knot Diameter Ratio): A correction factor for the amount of 
knots  in  the  sample. 
Setting CKDR to zero turns off CKDR correction.
• The  knot  diameter  is  a  distance  between  the  two  tangential  lines  parallel  to  arises 

(longitudinal direction) of a lumber surface in which the knot exists. If a knot diameter is not 
less than 2.5 times as much as its smallest diameter, it shall be considered to have one half 
of  its  actual  measured  diameter.  The  knot  diameter  ratio  (KDR)  is  a  percentage  of  the 
diameter of a knot to the width of a lumber surface in which it exists. The concentrated KDR 
(CKDR) is the sum of KDR concerning the knots existing in any 15 cm length of a piece of the 
lumber. The highest - considering 4 faces - CKDR represents the piece of lumber. The CKDR 
value is between 0 and 1.

• “Sample identifier (#)”: The sample identifier is an integer number (starting with 1) 
that uniquely identifies a lumber sample within the current project file. It is displayed 
in  the  “#” column  of  the  measurements  table.  It  may  be  entered  manually,  or 
increased by 1 using the “+” button. It is especially useful when storing multiple 
measurements of each lumber sample, as it indicates which measurement belongs 
to which sample.

• “Auto-increment”:  Indicates  whether  the  “Sample  identifier  (#)” is  automatically 
incremented after a successful grading. See also: 8.3 Miscellaneous settings.

5.3. Hammer usage
• Power: Grading is not sensitive to the power of hammer hits except for outliers: a 

weak hit produces a smaller signal and may fail to trigger. A powerful hit 
may move the lumber or damage the microphone. 

• Direction:  The software  measures longitudinal  vibration therefore the 
direction of hits must be parallel to the long axis of the lumber.

• Technique: There is no special technique to hits. Do not touch the lumber. Let the 
hammer bounce back. Refrain from doing weaker “test” hits.

• Hammer weight: The weight of the hammer is important: usually lighter is better, but 
larger lumber requires the use of heavier hammers. Roughly 0.1 – 3 % of the lumber 
weight is appropriate.

• Which Lumber end: Either end of the lumber is acceptable. Take special care not to 
damage the microphone.

6. Measurement result
The software window is immediately updated once a hit is detected.

6.1. Signal plot
• Displays  the  audio  waveform  that 

triggered the measurement
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• X axis: time in milliseconds

• “t”: the total duration of the audio sample that was analyzed

• “A”: the absolute maximum amplitude (Y value) in the waveform, in decibels

6.2. Frequency (FFT) plot
• Displays  the  frequencies  present 

within the audio sample analyzed

• X axis: frequency in Hertz

• Green  background:  the  frequency 
interval  within  which the  longitudinal 
frequency is searched for

• Red triangle and text: the longitudinal frequency detected, in Hertz. Note that the 
peak detected may not be the largest peak when  “Secondary peak detection” is 
enabled (see: 8.1 Audio settings).

• “A”: The maximum amplitude (Y value) detected, in decibels

• “SNR”: The signal-to-noise ratio within the audio sample analyzed, in decibels. A 
larger value indicates a clearer signal. See also: 8.2 Grading settings.

6.3. Results box
• “Density”: the estimated lumber density

• “Dynamic  MoE”:  the  dynamic  modulus  of 
elasticity  estimated  (the  MoE  based  on  the 
longitudinal velocity measurement)

• “Static  MoE”:  the  estimated  static  modulus  of 
elasticity (MoE under static load)

• “Velocity”:  the estimated velocity  of  the sound 
wave within the lumber

6.4. Strength class box
The large box below the “Next sample” and “Results” boxes displays the estimated 
strength class of the lumber if it could be graded, or the cause of the out-of-grade 
measurement.

• A  gray  background  indicates  that  the 
measurement could be graded.

• A  red  background  indicates  that  the  strength 
class could not be determined. In this case the 
box  contains  an  error  message  detailing  the 
cause. If there is no error message, than either one of the devices is not connected, 
or one of the “Next sample” fields is empty or out-of-range.
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6.5. Measurements storage & table

Measurements may be automatically or individually stored into the current project file. 
The currently stored measurements are displayed at the bottom of the “Record” tab, or 
on the “Data” tab, with the latest measurement located at the top of the table.

6.5.1. Storing new measurements
Measurements may be added to the currently 
open project either manually or automatically. Keep in mind that the project file must be 
saved using the File → Save or Save As menu commands (or when being notified about 
unsaved changes) to preserve measurements for later perusal.

• “Store”: this button is used to store the latest measurement, which is shown in the 
software.  Note  that  if  you  do  not  click  “Store”  and  instead  make  another 
measurement, then the button will only store the latest measurement and the one 
before is lost. You may use this button to only store the measurements you want to. 
(The button is disabled when there is no measurement to be stored, after the latest 
measurement was stored, or if “Auto store on hit” is enabled.)

• “Auto store on hit”: immediately stores the next measurement after the “Trigger” is 
detected.  The  “Sample  identifier  (#)” may  also  be  automatically  increased  as 
specified in the settings window (see: 8.3 Miscellaneous settings).

6.5.2. Deleting & exporting measurements
The content of the table may be edited using the buttons above it:

• “☰”: Allows exporting the content of the table into an Excel (.XLSX) file.

• “Delete last”: deletes that latest (i.e. top) measurement from the table

• “Delete selected”: deletes the selected row from the table

• “Delete  out-of-grade  rows”:  deletes  all 
rows  from  the  table  containing  out-of-
grade measurements (red backgrounds).
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6.5.3. Measurements table
The table contains the following columns:

• #: the “Sample identifier” of the lumber

• Timestamp: the time the measurement was taken. Only visible on the  “Data” tab 
and in exported Excel files.

• L, W, H [cm]: the length, width and height of the lumber, in centimeters

• Current MC [%]: the moisture content of the lumber while grading

• Service MC [%]: the moisture content of the lumber while in use

• CKDR: the “Concentrated Knot Diameter Ratio”

• Mass [kg]: the mass measured at the time the “Trigger” was detected

• Freq [Hz]: the longitudinal frequency detected, in Hertz

• Density [kg/m3]: the estimated density of the lumber in kilograms per cubic meters

• Velocity  [m/s]:  the  estimated  velocity  of  the  sound  wave  within  the  lumber,  in 
meters per second

• Static  MoE  [GPa]:  the  estimated  static  modulus  of  elasticity  of  the  lumber,  in 
gigapascals

• Class: the estimated strength class

7. Finishing the measurement
• Save the project: File → Save

• Turn off the Scale display unit to preserve battery life

8. Settings window
The settings window can be opened using the “Settings” menu command in the “File” 
menu.

8.1. Audio settings
• “Hit detection pause”: After each Trigger detected the microphone stops recording 

for a very short while. This allows the sound of the hit to dissipate (avoiding multiple 
Triggers for the same hit).

• “Secondary peak detection”: The detection of secondary peaks is an optional feature 
useful when the frequency plot (see:  6.2 Frequency (FFT) plot) shows two peaks 
close to each other. When “OFF”, the largest (maximum) peak is selected from the 
frequency search range (green background).  The second highest peak is selected 
instead when “ON” (and a second peak exists).
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• “Sensitivity”:  The  minimum  magnitude  of  the  secondary  peak,  defined  as  a 
percentage of the current primary (maximum) peak. A larger value indicates that 
the secondary peak should be closer in magnitude (Y axis) to the primary peak.

• “Frequency  range”:  The  secondary  peak  is  only  searched  for  in  the  close 
neighborhood of the primary peak, directly to the left from it (the secondary peak 
is expected to have a smaller frequency). The exact range of frequencies checked 
is defined as a percentage of the total frequencies shown in the plot (the X axis).

8.2. Grading settings
• The “Upper limit” fields help determine when the static MoE or density values of the 

current measurement can not be graded. The minimum of the valid range for each of 
the two is defined by the EN 338 standard (see:  Appendix 2: EN 338) however the 
maximum is not. We introduce these maximum values to indicate when static MoE or 
density is obviously erroneous (this may happen when small numbers are entered as 
the sample dimensions).

• “Minimum signal-to-noise ratio (SNR)”: Environmental noise can affect the grading 
algorithm negatively. This value is a minimum for the ratio of the magnitude of the 
peak detected,  and the average magnitude of  the frequency search range (green 
background), defined in decibels.  The measurement is considered unusable when 
the  noise  is  too  high  (SNR  is  less  then  this  number).  The  SNR  for  the  latest 
measurement is indicated on the frequency plot (see: 6.2 Frequency (FFT) plot).

8.3. Miscellaneous settings
• “Auto-increment min. sample count”: this number determines when to automatically 

increment  the  “Sample  identifier  (#)”. It  has  no  effect  when  “Auto-increment” is 
unchecked (see: 5.2 Properties of the next lumber sample).

• When  set  to  1:  The  sample  identifier  is  increased  after  each  gradable 
measurement.

• When greater  than 1:  The sample identifier  is  increased only  after  this  many 
gradable measurements are available for the current sample identifier. Out-of-
grade measurements (red background) are ignored. In this case there is also a 
short sound effect played when the sample identifier is increased, so that the 
user knows when enough gradable measurements were taken without having to 
look at the screen.

• “Open autosave directory”:  Copies of recently open projects are preserved in this 
location temporarily. In case of data loss (due to power or storage failure) you may 
be able to find a copy of the project based on when it was last open.
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9. Troubleshooting

9.1. Audio device issues

When there is an issue with the microphone you should see the red “Error” indicator, and 
you may also see the “[DISCONNECTED]” suffix in the audio device selector.

• Ensure  that  the  microphone  is  well 
connected to the computer

• Ensure that the microphone is not disabled 
in Windows (see: Settings / System / Sound / 
Advanced / More sound settings / Recording)

• Click “Reset device”

• Ensure  that  the  correct  audio  device  is 
selected

9.2. Weighing scale issues

Multiple issues could occur with the scale:

• The “[DISCONNECTED]” suffix appears in the device selector when the cable was 
unplugged. Ensure that the cable fully plugged into the computer. You may also try 
to use another socket if the issue persists.

• The  “Connecting” and  “Disconnecting” yellow status messages may appear for a 
long amount of time (up to a couple minutes in extreme cases). This issue should 
resolve itself automatically. You may also try restarting the application and/or the 
computer.

• The  red  “Error” status  message  may  appear  either  because  the  device  is 
“[DISCONNECTED]” (see above),  or  due to another  communication issue.  If  the 
suffix is  not visible, try to clicking the  “Close” button, and once that finishes the 
“Open” button.
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• The yellow “No data” status message indicates that no data is received from the 
device. First ensure that the correct COM port is selected (you may need to click 
the “Close” button to do so). You should also ensure that the display unit is turned 
on and has a fully charged battery.

• The “Total weight” box may display a red background and “- - - -”. This indicates 
that no data is received from the device. Usually you also see the “No data” yellow 
status message (see above), however this may also be caused by data corruption. 
The latter may be caused by low battery voltage and bad cable connections (check 
that cables between the scale, display unit and computer are well connected). It 
may also be caused by damage to one of the cables. If none of the steps above 
resolve the issue, try replacing the USB-serial cable or contact support.

9.3. Trigger level issues
A correctly configured trigger level detects all hits, but only the hits.

• When random noise is detected as hits, the trigger level is too low and picks up noise. 
Observe the level of the dark blue bar when noise occurs and ensure the trigger level 
(red line) is above it.

• When hits are missed, the trigger level is too high and should be lowered. Observe 
the level of the dark blue bar when hits occur and ensure the trigger level (red line) is 
below it. This can also be caused when the microphone is too far away from the end 
of the lumber (the distance should be around 5 centimeters between the microphone 
head and the end of the lumber).

• A red background at the top of the audio level indicator signals that 
the audio volume is too high. As this may distort the signal, move the 
microphone slightly  away from the lumber (a  distance of  around 5 
centimeters is recommended).

9.4. Grading errors

The large grading result box may indicate multiple issues:

• “Static MoE below lower limit” or  “Density below lower limit”: The measured static 
MoE or density was too low. The lower limit is determined by the EN 338 standard 
(see the left-most values in the coniferous or deciduous tables in  Appendix 2: EN
338) Ensure that the dimensions are correct and that the measured weight is correct 
(check whether full/half weight measurement is selected in the software). Repeat 
the hit on the lumber, making sure to hit the center and not the edges.
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• “Static MoE above upper limit” or  “Density above upper limit”: the issue is usually 
resolved similarly to the “lower limit” errors above. If you are measuring lumber with 
unusual  properties  (e.g.  extreme  density),  you  may  manually  increase  the  upper 
limits (see 8.2 Grading settings)

• “High  background  noise”:  Ensure  that  the  microphone  is  well  connected  to  the 
computer and is placed reasonably close to the lumber (around 5 centimeters). You 
may also wish to ensure that the environment has no other sources of noise and that 
the microphone is undamaged. Decreasing the minimum signal-to-noise ratio may 
also resolve such issues, however please be aware that this may negatively affect the 
accuracy of grading (see 8.2 Grading settings). The signal-to-noise ratio at the time 
of the hit is displayed on the Frequency (FFT) plot.

• An empty red grading box indicates that grading can not be completed. Check that 
there are no issues indicated with the microphone and weighing scale, and that the 
lumber parameters are valid numbers (invalid user input is marked by red borders).

9.5. File errors
Damaged or lost project files may be recoverable if they were recently opened using the 
“Open autosave directory” button of the Settings window (see: 8.3 Miscellaneous settings)
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10. Appendix 1: Mathematical model
The software models lumber using the following formula:

where:

ρ: density in kg
m3

m: mass in [kg]

L: length in [m] W: width in [m] H: height in [m]

10.1. Velocity
Velocity is derived from the longitudinal frequency of the lumber (estimated from the 
peak detected in the measurement).

where:

v: velocity in m
s

L: length in [m] f: frequency in [Hz]

10.2. Dynamic MoE

where:

MoEd: moisture corrected dynamic modulus of elasticity, in [Pa]

ρ: density in kg
m3

v: velocity in m
s

u: moisture difference in [%]: service moisture [%] - current moisture [%]

10.3. Static MoE
The estimation for the Static MoE comes from the PhD work of Ferenc Sismándy-Kiss: 
Relationship Between the Strength and Physical Properties of Sawn Timber (2012)

where:

13

v=2⋅L⋅f

ρ= m
(L⋅W⋅H )

MoEd=ρ⋅v
2⋅(1− u

50
)

MoEs ,GPa=0.819⋅MoEd ,GPa+1.158−(1.981⋅CKDR)



• MoEs ,GPa: static modulus of elasticity, in [GPa]

• MoEd ,GPa: dynamic modulus of elasticity, in [GPa] (MoEd ,GPa=
MoEd
109

)

• CKDR: Concentrated Knot Diameter Ratio (dimensionless quantity)

11. Appendix 2: EN 338
Strength classes for softwood (coniferous species):

C14 C16 C18 C20 C22 C24 C27 C30 C35 C40 C45 C50
MoE [GPa] 7 8 9 9.5 10 11 11.5 12 13 14 15 16
ρ [kg/m3] 290 310 320 330 340 350 360 380 390 400 410 430

Strength classes for hardwoods (deciduous species):

D18 D24 D27 D30 D35 D40 D45 D50 D55 D60 D65 D70 D75 D80
MoE [GPa] 9.5 10 10.5 11 12 13 13.5 14 15.5 17 18.5 20 22 24
ρ [kg/m3] 475 485 510 530 540 550 580 620 660 700 750 800 850 900

The numbers shown are the minimum values for each strength class. If static MoE and 
density indicate different strength classes, then the smaller class is chosen.

12. Appendix 3: Technical data
Weighing scale

• Dimensions: 250 x 75 x 90 mm

• Max capacity: 500 kg

• Resolution: 10 g

• Output: RS232 signal

• Power  supply:  12 V  adapter  or  4  AA 
size batteries

Microphone

• Type: unidirectional

• Sensitivity: -56 dB (0 dB = 1 V/mbar at 
1000 Hz)

• Frequency range: 100 - 15000 Hz

• Operational temperature: 5 - 40 °C

Hammer

• Weight: 0.1 – 3% of lumber weight

Limitations

• The actual lumber dimensions need 
to  be  within  ±2%  of  the  nominal 
dimensions entered.

• The  lumber  length  must  be  within 
the range of: 0.5m ... 10m
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